Hydroacoustic Survey of Black Rockfish Abundance and Distribution Operational Plan for the Afognak and Northeast Districts of the Kodiak Management Area, 2015

by

Philip Tschersich
Symbols and Abbreviations

The following symbols and abbreviations, and others approved for the Système International d'Unités (SI), are used without definition in the following reports by the Divisions of Sport Fish and of Commercial Fisheries: Fishery Manuscripts, Fishery Data Series Reports, Fishery Management Reports, and Special Publications. All others, including deviations from definitions listed below, are noted in the text at first mention, as well as in the titles or footnotes of tables, and in figure or figure captions.

<table>
<thead>
<tr>
<th>Weights and measures (metric)</th>
<th>General</th>
<th>Mathematics, statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>centimeter cm</td>
<td>centimeter cm</td>
<td>all standard mathematical symbols, signs, and abbreviations</td>
</tr>
<tr>
<td>decimeter dL</td>
<td>decimeter dL</td>
<td>alternate hypothesis $H_a$</td>
</tr>
<tr>
<td>gram g</td>
<td>gram g</td>
<td>base of natural logarithm $e$</td>
</tr>
<tr>
<td>hectare ha</td>
<td>hectare ha</td>
<td>catch per unit effort CPUE</td>
</tr>
<tr>
<td>kilogram kg</td>
<td>kilogram kg</td>
<td>coefficient of variation CV</td>
</tr>
<tr>
<td>kilometer km</td>
<td>kilometer km</td>
<td>common test statistics (F, t, $\chi^2$, etc.)</td>
</tr>
<tr>
<td>liter L</td>
<td>liter L</td>
<td>confidence interval CI</td>
</tr>
<tr>
<td>meter m</td>
<td>meter m</td>
<td>correlation coefficient $R$</td>
</tr>
<tr>
<td>milliliter mL</td>
<td>milliliter mL</td>
<td>correlation coefficient $r$</td>
</tr>
<tr>
<td>millimeter mm</td>
<td>millimeter mm</td>
<td>covariance $cov$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weights and measures (English)</th>
<th>General</th>
<th>Mathematics, statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>cubic feet per second ft/s</td>
<td>cubic feet per second ft/s</td>
<td>degree (angular) $^\circ$</td>
</tr>
<tr>
<td>foot ft</td>
<td>foot ft</td>
<td>degrees of freedom df</td>
</tr>
<tr>
<td>gallon gal</td>
<td>gallon gal</td>
<td>expected value $E$</td>
</tr>
<tr>
<td>inch in</td>
<td>inch in</td>
<td>greater than $&gt;$</td>
</tr>
<tr>
<td>mile mi</td>
<td>mile mi</td>
<td>greater than or equal to $\geq$</td>
</tr>
<tr>
<td>nautical mile nmi</td>
<td>nautical mile nmi</td>
<td>harvest per unit effort HPUE</td>
</tr>
<tr>
<td>ounce oz</td>
<td>ounce oz</td>
<td>less than $&lt;$</td>
</tr>
<tr>
<td>pound lb</td>
<td>pound lb</td>
<td>less than or equal to $\leq$</td>
</tr>
<tr>
<td>quart qt</td>
<td>quart qt</td>
<td>logarithm (natural) $\ln$</td>
</tr>
<tr>
<td>yard yd</td>
<td>yard yd</td>
<td>logarithm (base 10) log</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time and temperature</th>
<th>General</th>
<th>Mathematics, statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>day d</td>
<td>day d</td>
<td>logarithm (specify base) log</td>
</tr>
<tr>
<td>degrees Celsius $^\circ$C</td>
<td>degrees Fahrenheit $^\circ$F</td>
<td>logarithm (multiple) $\log_e, \log_{10}$, etc.</td>
</tr>
<tr>
<td>degrees Kelvin K</td>
<td>degrees Kelvin K</td>
<td>minute (angular) $'$</td>
</tr>
<tr>
<td>hour h</td>
<td>hour h</td>
<td>not significant NS</td>
</tr>
<tr>
<td>minute min</td>
<td>minute min</td>
<td>null hypothesis $H_0$</td>
</tr>
<tr>
<td>second s</td>
<td>second s</td>
<td>percent $%$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Physics and chemistry</th>
<th>General</th>
<th>Mathematics, statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>all atomic symbols</td>
<td>all atomic symbols</td>
<td>probability of a type I error $\alpha$</td>
</tr>
<tr>
<td>alternating current AC</td>
<td>alternating current AC</td>
<td>(rejection of the null hypothesis when true) $\alpha$</td>
</tr>
<tr>
<td>ampere A</td>
<td>ampere A</td>
<td>probability of a type II error $\beta$</td>
</tr>
<tr>
<td>calorie cal</td>
<td>calorie cal</td>
<td>(acceptance of the null hypothesis when false) $\beta$</td>
</tr>
<tr>
<td>direct current DC</td>
<td>direct current DC</td>
<td>second (angular) $^\circ$</td>
</tr>
<tr>
<td>hertz Hz</td>
<td>hertz Hz</td>
<td>standard deviation SD</td>
</tr>
<tr>
<td>horsepower hp</td>
<td>horsepower hp</td>
<td>standard error SE</td>
</tr>
<tr>
<td>hydrogen ion activity (negative log of) pH</td>
<td>hydrogen ion activity (negative log of) pH</td>
<td>variance</td>
</tr>
<tr>
<td>parts per million ppm</td>
<td>parts per million ppm</td>
<td>population Var</td>
</tr>
<tr>
<td>parts per thousand ppt, $%$</td>
<td>parts per thousand ppt, $%$</td>
<td>sample std</td>
</tr>
<tr>
<td>volts V</td>
<td>volts V</td>
<td>use two-letter abbreviations (e.g., AK, WA)</td>
</tr>
<tr>
<td>watts W</td>
<td>watts W</td>
<td>use two-letter abbreviations (e.g., AK, WA)</td>
</tr>
</tbody>
</table>
REGIONAL OPERATIONAL PLAN CF.4K.2015.18

HYDROACOUSTIC SURVEY OF BLACK ROCKFISH ABUNDANCE AND DISTRIBUTION OPERATIONAL PLAN FOR THE AFOGNAK AND NORTHEAST DISTRICTS OF THE KODIAK MANAGEMENT AREA, 2015

by

Philip Tschersich

Alaska Department of Fish and Game, Division of Commercial Fisheries, Kodiak

Alaska Department of Fish and Game
Division of Commercial Fisheries
June 2015
The Regional Operational Plan Series was established in 2012 to archive and provide public access to operational plans for fisheries projects of the Divisions of Commercial Fisheries and Sport Fish, as per joint-divisional Operational Planning Policy. Documents in this series are planning documents that may contain raw data, preliminary data analyses and results, and describe operational aspects of fisheries projects that may not actually be implemented. All documents in this series are subject to a technical review process and receive varying degrees of regional, divisional, and biometric approval, but do not generally receive editorial review. Results from the implementation of the operational plan described in this series may be subsequently finalized and published in a different department reporting series or in the formal literature. Please contact the author if you have any questions regarding the information provided in this plan. Regional Operational Plans are available on the Internet at: http://www.adfg.alaska.gov/sf/publications/

Philip Tschersich,
Alaska Department of Fish and Game, Division of Commercial Fisheries
351 Research Court, Kodiak, AK 99615, USA

This document should be cited as:
Tschersich, P. 2015. Hydroacoustic survey of black rockfish abundance and distribution operational plan for the Afognak and Northeast Districts of the Kodiak Management Area, 2015. Alaska Department of Fish and Game, Division of Commercial Fisheries, Regional Operational Plan ROP.CF.4K.2015.18, Kodiak.

The Alaska Department of Fish and Game (ADF&G) administers all programs and activities free from discrimination based on race, color, national origin, age, sex, religion, marital status, pregnancy, parenthood, or disability. The department administers all programs and activities in compliance with Title VI of the Civil Rights Act of 1964, Section 504 of the Rehabilitation Act of 1973, Title II of the Americans with Disabilities Act (ADA) of 1990, the Age Discrimination Act of 1975, and Title IX of the Education Amendments of 1972.

If you believe you have been discriminated against in any program, activity, or facility please write: ADF&G ADA Coordinator, P.O. Box 115526, Juneau, AK 99811-5526

U.S. Fish and Wildlife Service, 4401 N. Fairfax Drive, MS 2042, Arlington, VA 22203
Office of Equal Opportunity, U.S. Department of the Interior, 1849 C Street NW MS 5230, Washington DC 20240

The department's ADA Coordinator can be reached via phone at the following numbers:
(VOICE) 907-465-6077, (Statewide Telecommunication Device for the Deaf) 1-800-478-3648,
(Juneau TDD) 907-465-3646, or (FAX) 907-465-6078

For information on alternative formats and questions on this publication, please contact: ADF&G, Division of Sport Fish, Research and Technical Services, 333 Raspberry Rd, Anchorage AK 99518 (907) 267-2375
**Signature Page**

**Project Title:** Hydroacoustic Survey of Black Rockfish Abundance and Distribution Operational Plan for the Afognak and Northeast Districts of the Kodiak Management Area, 2015

**Project leader(s):**
- Carrie Worton, Fishery Biologist III
- Philip Tschersich, Fishery Biologist II

**Division, Region, and Area:** Division of Commercial Fisheries, Region IV, Kodiak

**Project Nomenclature:**

**Period Covered:** 2015

**Field Dates:** May–August

**Plan Type:** Category II

---

### Approval

<table>
<thead>
<tr>
<th>Title</th>
<th>Name</th>
<th>Signature</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Leader</td>
<td>Philip Tschersich</td>
<td></td>
<td>6-18-15</td>
</tr>
<tr>
<td>Biometrician</td>
<td>Dave Barnard</td>
<td></td>
<td>7-18-15</td>
</tr>
<tr>
<td>Section Supervisor</td>
<td>Doug Pengilly</td>
<td></td>
<td>7-22-15</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST OF TABLES</td>
<td>iii</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>iii</td>
</tr>
<tr>
<td>LIST OF APPENDICES</td>
<td>iv</td>
</tr>
<tr>
<td>PURPOSE</td>
<td>1</td>
</tr>
<tr>
<td>BACKGROUND</td>
<td>1</td>
</tr>
<tr>
<td>OBJECTIVES</td>
<td>3</td>
</tr>
<tr>
<td>METHODS</td>
<td>3</td>
</tr>
<tr>
<td>2015 Survey Design</td>
<td>4</td>
</tr>
<tr>
<td>Hydroacoustic Data Acquisition</td>
<td>7</td>
</tr>
<tr>
<td>Rockfish Density and Abundance Estimation</td>
<td>7</td>
</tr>
<tr>
<td>Sampling for Species Determination</td>
<td>7</td>
</tr>
<tr>
<td>SCHEDULE AND DELIVERABLES</td>
<td>8</td>
</tr>
<tr>
<td>RESPONSIBILITIES</td>
<td>8</td>
</tr>
<tr>
<td>REFERENCES CITED</td>
<td>9</td>
</tr>
<tr>
<td>APPENDIX A. ECHOGRAM ANALYSIS USING MYRIAX ECHOVIEW</td>
<td>11</td>
</tr>
<tr>
<td>APPENDIX B. STATISTICAL EXPANSION OF HYDROACOUSTICALLY-DERIVED FISH COUNTS</td>
<td>29</td>
</tr>
<tr>
<td>APPENDIX C. PROCESSING HYDROACOUSTICALLY-DERIVED FISH LOCATIONS AND BATHYMETRY IN MINITAB</td>
<td>33</td>
</tr>
<tr>
<td>APPENDIX D. USE OF THE NAUTICAL CHARTING PROGRAM COASTAL EXPLORER 2009</td>
<td>57</td>
</tr>
<tr>
<td>APPENDIX E. SETUP AND USE OF THE HYDROACOUSTIC SYSTEM</td>
<td>61</td>
</tr>
<tr>
<td>APPENDIX F. UNDERWATER VIDEO SYSTEM</td>
<td>71</td>
</tr>
<tr>
<td>APPENDIX G. LIVE CAPTURE SAMPLING PROCEDURES</td>
<td>83</td>
</tr>
</tbody>
</table>

## LIST OF TABLES

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Summary of management areas and districts surveyed for black and dark rockfish abundance from 2007 to 2014 with scheduled surveys for 2015 shown.</td>
<td>2</td>
</tr>
<tr>
<td>2. Hydroacoustic survey schedule and responsibilities, 2015.</td>
<td>8</td>
</tr>
</tbody>
</table>

## LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Map of the management areas and districts in the Westward Region.</td>
<td>3</td>
</tr>
<tr>
<td>2. Example of a vessel’s transects (numbered solid black lines) for a star-pattern survey station over a rock pinnacle with rockfish (grey circles) detected by the hydroacoustic beam indicated.</td>
<td>5</td>
</tr>
<tr>
<td>3. Example of a vessel’s transects (numbered solid black lines) for a grid-pattern survey station over a reef system with rockfish (grey circles) detected by the hydroacoustic beam indicated.</td>
<td>6</td>
</tr>
</tbody>
</table>
**LIST OF APPENDICES**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Echogram analysis using Myriax Echoview</td>
<td>12</td>
</tr>
<tr>
<td>B1</td>
<td>Statistical expansion of hydroacoustically-derived fish counts</td>
<td>30</td>
</tr>
<tr>
<td>C1</td>
<td>Processing the hydroacoustically derived fish locations and bottom soundings in Minitab</td>
<td>34</td>
</tr>
<tr>
<td>D1</td>
<td>Drawing Grid and Star Survey Routes in Coastal Explorer 2009</td>
<td>58</td>
</tr>
<tr>
<td>E1</td>
<td>Configuration of the Biosonics hydroacoustic transducer, cable, DT-X controller, GPS, and computer</td>
<td>62</td>
</tr>
<tr>
<td>E2</td>
<td>Use of Biosonic’s Visual Acquisition to record and view the hydroacoustic echogram</td>
<td>65</td>
</tr>
<tr>
<td>F1</td>
<td>Instructions for assembly and use of the Insite underwater video camera system</td>
<td>72</td>
</tr>
<tr>
<td>G1</td>
<td>Live capture sampling procedures</td>
<td>84</td>
</tr>
<tr>
<td>G2</td>
<td>Instructions for operating an Oilwind 03-16 electronic jig machine</td>
<td>89</td>
</tr>
</tbody>
</table>
PURPOSE

A hydroacoustic survey of rockfish abundance and distribution in the Afognak and Northeast districts of the Kodiak Management area will be performed by the Alaska Department of Fish and Game (ADF&G) in 2015. This survey represents an ongoing effort to develop a district-level, abundance-based management plan for black rockfish *Sebastes melanops* in the Kodiak, Chignik, and South Alaska Peninsula groundfish management areas. Hydroacoustic surveys are used to generate black rockfish abundance estimates for each area district that can be used to guide harvest level decisions by fishery managers. We use hydroacoustics to count rockfish in transect samples and statistically expand fish counts to generate a density and abundance estimate for all species of rockfish within each survey station. Underwater video is used to estimate species composition of rockfish in survey stations and apportion abundance estimates to those species. Repeating these surveys in predefined survey stations over multiple years generates an index of abundance which provides an indication of population changes. The data collected by this study are used in annual evaluations of guideline harvest levels (GHLs) for black rockfish and are needed for development of an abundance-based harvest and management strategy for black rockfish.

Key words: hydroacoustic, survey, black rockfish, *Sebastes melanops*, Kodiak Management Area, guideline harvest levels

BACKGROUND

Directed commercial rockfish fisheries have occurred in the Gulf of Alaska since 1990 (Stichert 2009; Hartill et al. 2014). Covering all waters within the Kodiak, Chignik, and South Alaska Peninsula areas and state waters of the Bering Sea-Aleutian Islands Area the Westward Region black rockfish *Sebastes melanops* fishery is the largest in the state both geographically and in terms of harvest. Full management authority of black rockfish and dark *S. ciliatus* rockfish were transferred from Federal agencies to the State of Alaska in 1998 and 2009, respectively (Lunsford et al. 2009). Existing harvest guidelines for black rockfish are based on an average of historic commercial fishery harvests and divided into GHLs for each district in order to distribute effort within each management area. Dark rockfish are currently harvested only at bycatch levels. It is unknown whether current harvest levels are sustainable for these species (Worton and Rosenkranz 2003), as both species exhibit life-history characteristics that may make them intrinsically sensitive to overfishing such as slow growth, long-lived, low natural morality, and high age of maturity (Worton and Rosenkranz 2003; ADF&G unpublished data). Of particular concern are dark rockfish (maximum age of approximately 75 years, ADF&G, unpublished data) which are a nearshore species that often occur in the same location as black rockfish (maximum age of 56 years, ADF&G, unpublished data). Part of the State of Alaska’s management responsibility includes conducting stock status assessments of commercially exploited fish populations with the goal of managing for sustainability (Carlile 2005). With the state responsible for management, developing a sustainable harvest strategy which incorporates both of these co-occurring species is becoming increasingly important.

In 2003, ADF&G started developing hydroacoustic survey methods for black and dark rockfish, and since 2007 has conducted annual hydroacoustic surveys for black rockfish in the Kodiak Management Area (KMA). The Northeast District of the KMA was first surveyed with

---

hydroacoustics in 2007 in order to refine the methodology for determining rockfish habitat locations and extent, determine protocols for the collection and analysis of the hydroacoustic echogram, and evaluate live-capture sampling and underwater video as a means to determine species composition (Table 1). Due to technical difficulties, underwater video was not used extensively in 2007, but the Northeast District was surveyed with the hydroacoustic system and rockfish were sampled at many survey locations through live capture. The survey of the Northeast District was repeated and refined in 2008, and extensive underwater video was recorded at most survey locations for species determination. In 2009, surveys were conducted in the Afognak, Eastside, and Southeast districts of the KMA using the now-standardized protocols outlined in this document (Table 1). Other districts within the KMA, Chignik Management Area (CMA), and the South Alaska Peninsula Management Area (SAPMA) have been surveyed at least one time with the goal of developing a baseline of rockfish distribution and abundance data for these areas. A timeline of districts and management areas surveyed is detailed in Table 1 and a map depicting management areas and associated districts can be seen in Figure 1.

Table 1.—Summary of management areas and districts surveyed for black and dark rockfish abundance from 2007 to 2014 with scheduled surveys for 2015 shown.

<table>
<thead>
<tr>
<th>Management Area</th>
<th>District</th>
<th>Survey Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>X X - - X X X</td>
<td></td>
</tr>
<tr>
<td>Eastside</td>
<td>- - X - - X X</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>- - X - X - X</td>
<td></td>
</tr>
<tr>
<td>Southwest</td>
<td>- - - - X - -</td>
<td></td>
</tr>
<tr>
<td>Westside</td>
<td>- - - X X - -</td>
<td></td>
</tr>
<tr>
<td>Mainland</td>
<td>- - - X - - -</td>
<td></td>
</tr>
<tr>
<td>Chignik</td>
<td>Sutwik Island</td>
<td>X - - - -</td>
</tr>
<tr>
<td>Chignik Bay</td>
<td>X - - - X - -</td>
<td></td>
</tr>
<tr>
<td>Mitrofania</td>
<td>- - - X - - -</td>
<td></td>
</tr>
<tr>
<td>S AK Peninsula</td>
<td>Shumagin Is</td>
<td>X - - - -</td>
</tr>
</tbody>
</table>

* Surveys scheduled to be performed in 2015
OBJECTIVES

The objectives of the 2015 hydroacoustic surveys of black rockfish are as follows:

1. Estimate the abundance, density, and associated standard error of black rockfish and other co-occurring rockfish species in the Northeast and Afognak districts of the KMA.

2. Update the relative abundance index and population estimates for black rockfish in each of the Northeast and Afognak Districts of the KMA with data for 2015.

3. Provide data for assessing temporal and spatial trends in rockfish density and species composition over the surveyed areas of the Northeast and Afognak Districts of the KMA in 2015.

METHODS

The 2015 hydroacoustic black rockfish surveys will be conducted onboard two research vessels. The majority of the Northeast District will be surveyed during day trips out of the Port of Kodiak on the 26-foot R/V Instar, while the Afognak District and those portions of the Northeast District too distant for day trips out of the Port of Kodiak will be surveyed using the 42-foot R/V K-Hi-C. The surveys cover nearshore habitat (generally inside state waters) of known black rockfish aggregations that are commercially fished and have been documented on previous surveys. Fish abundance data will be collected using split-beam hydroacoustics, and fish species data will be collected using an underwater drop video camera system and live capture.
**2015 Survey Design**

A total of 62 hydroacoustic survey stations have been established in the Northeast District and 78 have been established in the Afognak District (Figures 4 and 5, respectively, in Tschersich 2015). A survey station encompasses a single, largely contiguous and geographically compact area of rockfish habitat (e.g., a reef or pinnacle). Survey station areas can range from as small as 0.05 km$^2$ for an isolated pinnacle to over a square kilometer for a large, continuous reef structure. Survey stations were initially developed using commercial fishing logbooks, bathymetric features from charts and sounding data, using interviews with commercial and sport fishermen, and other sources. Once areas of interest were identified, survey stations were established by exploring the geographic extent of those habitats using hydroacoustics and establishing the presence or absence of rockfish associated with those habitat structures. Shallow areas with kelp cover, typically juvenile rockfish habitat, are inaccessible by the vessel and survey equipment. As a result only habitats associated with adult black rockfish were incorporated into the survey.

Two kinds of survey stations, defined by their different patterns in sampling transect design, are used in the survey: “star-pattern” survey stations and “grid-pattern” survey stations. If a survey station samples from habitat and fish aggregations that are focused on a location with a single spatially-discrete feature, such as a rock pinnacle, with a defined central fish density, a star-pattern transect is used to survey the area (Figure 2). The center of the pattern crosses over the center of the fish aggregation with five evenly-spaced, equal-length transects. Because star-pattern survey transects are used on a spatially-focused habitat feature or fish school, the diameter of the star is typically set at 0.3 km. (If a location requires transects longer than 0.3 km in order to encompass the habitat, it is likely not a good candidate for a star-pattern station and a grid-pattern station may be more appropriate). If the habitat or fish schools are more spatially variable and cannot be adequately covered in a small-diameter star pattern, a series of parallel grid-pattern transects are used (Figure 3). The grid pattern is the preferred method for density estimation and should be used whenever possible. Parallel transect tracks are spaced 50 m apart to form a grid pattern. Individual transects in a grid-pattern station may be of any length and the grids can have any number of transects, though for statistical reasons the minimum number of transects is three. When necessary, the sampling design is adjusted to incorporate a minimum of three transects by decreasing spacing of each transect or increasing the station area. The hydroacoustic survey includes the entire habitat area and extends a short distance (approximately 20 m) beyond the main fish aggregations and bathymetric features of interest to ensure that the entirety of the area is covered. If a habitat area is determined to be very large (e.g., greater than 2 km long or wide) or exists in a complex geometry, multiple closely-neighbored grid stations are created to cover the area.
Figure 2.—Example of a vessel’s transects (numbered solid black lines) for a star-pattern survey station over a rock pinnacle with rockfish (grey circles) detected by the hydroacoustic beam indicated.
Figure 3.—Example of a vessel’s transects (numbered solid black lines) for a grid-pattern survey station over a reef system with rockfish (grey circles) detected by the hydroacoustic beam indicated.

Detailed descriptions of survey stations established in the Northeast and Afognak districts, including the beginning and ending latitudes and longitudes of each transect, are provided in Tschersich (2015). Stations that have been sampled in every survey of a given district since that district was first surveyed (see Table 1) are designated “index stations,” and provide data for computing a relative abundance index to evaluate changes in the black rockfish population over time. Stations added after the first survey of a given district are designated as “population stations,” which, in conjunction with data from index stations, provide data for estimating the total rockfish population for the district.

All 67 index stations and all 10 population stations established in Afognak District (Table 1 in Tschersich 2015) will be sampled during the 2015 survey for a total surveyed area of 8.89 km$^2$. In 2015, all 28 index stations and all 13 population stations established in Northeast District (Table 2 and Figure 5 in Tschersich 2015) will be sampled for a total surveyed area of 12.01 km$^2$.

If new aggregations of black rockfish are identified during the survey, new stations will be created and added to the catalog of survey stations to more fully document black rockfish overall distribution and abundance. If a new survey station is identified and its survey-transect pattern (grid or star) determined, it will be drawn into a nautical navigation and charting program in such a way that the vessel operator can follow it precisely and so that either the vessel operator or a
technician can enter marks in the navigation program indicating where fish concentrations are seen on the echogram. A detailed description of the use of the nautical charting program *Coastal Explorer 2009* is presented in Appendix D.

**Hydroacoustic Data Acquisition**

This study employs a Biosonics DT-X 210 kHz split-beam echo sounder (Seattle, WA, www.biosonicsinc.com) to record fish in the water column over black rockfish habitats. A detailed description of the setup and use of the hydroacoustic system is presented in Appendix E. The transducer is mounted on either a tow-beside sled or on a pole attached to the vessel’s gunnel near the midship line. The advantage to the pole-mounted transducer setup is that it can be left in the water during all survey operations whereas the sled-mounted transducer needs to be lifted on board during vessel travel at speeds exceeding 5 knots and during live-capture and video sampling. In either configuration, the transducer must be approximately 2 m below the surface of the water at a depth sufficient to ensure it is out of any bubble layers or turbulence created by the boat. The data from the transducer is fed through the Biosonics DT-X surface unit housed in a Pelican case where GPS position information is added to the data stream, and then it is transferred to a computer via an Ethernet cable for real-time viewing and recording on a computer hard drive in Biosonic’s Visual Acquisition software program.

Individual fish within the acoustic beam are resolved from the recorded echogram using Echoview (Myriax, Hobart Australia; Appendix A). The depth in meters and location data in decimal degrees lat. and long. are recorded for individual fish in each of the station’s transects. Due to the relatively narrow beam of the hydroacoustic system (6.2°), recording the entire water volume in the study area is not feasible, therefore transect sampling across the area is used. Transects on a typical grid-pattern study area are spaced 50 m apart and each transect is treated as a sample. Given a 50 m transect spacing and an average depth of approximately 37 m for typical black rockfish habitat, the resulting ensonified volume of water recorded in the echogram represents approximately four percent of the total water volume over the study area. A typical station will have an area of approximately 0.12 km² and is transited by six transects.

**Rockfish Density and Abundance Estimation**

Fish density from the echogram is calculated using a method described by Yule (2000) and is briefly described in Appendix B. This methodology is applied in the statistical software Minitab (Minitab 17 Statistical Software 2010, State College, PA) to obtain a fish density for each transect, a mean fish density across all station transects, and a standard error and coefficient of variation for the mean density. Each station’s mean fish density is used to calculate an estimated total number of rockfish when multiplied by the station’s area. The station area is defined as the least convex polygon joining the station’s transect endpoints. The processing of edited hydroacoustic data in Minitab is described in Appendix C.

**Sampling for Species Determination**

Whereas adult fish of the genus *Sebastes* can generally be identified from the echogram, a species-level determination of rockfish types in aggregations is made visually using underwater video or by capturing fish with hook and line and bringing them to the surface. This species proportion data is used to apportion the hydroacoustic fish counts by multiplying the total rockfish estimate from the statistical expansion by the percentage of each species determined in the video review. The video almost universally results in a larger sample size of fish being
identified compared to live capture, and is not affected by species-specific susceptibility to fishing gear. Because of these factors, acquiring quality video footage from a variety of locations on a grid, or from the main fish aggregation in a star, is of primary importance and takes precedence over live capture sampling. The live capture sampling is performed in order to gather data on sex composition, length frequencies, and to document the reproductive status of fish in the survey. These data represent an ancillary collection and are not directly used in the abundance determination of black rockfish but help build a more comprehensive picture of the population. The underwater video system uses a pair of NTSC cameras that offer a view in opposite directions out of a rigid housing. The housing is suspended over the side of the vessel at the end of a cable, and is passively drifted through schools of fish that were identified during the acquisition of the hydroacoustic echogram and noted on marine charting software. A detailed description of the underwater video collection and live capture procedures are provided in Appendices F and G, respectively.

**SCHEDULE AND DELIVERABLES**

The table below shows activities scheduled for the 2015 survey season. While rockfish abundance research is an ongoing effort, each season’s specific activities and timeframe will depend on personnel and vessel availability, weather, and funding.

<table>
<thead>
<tr>
<th>Date</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>May 19–May 26</td>
<td>Survey of the Chiniak area in the Northeast District and begin the Afognak District of the KMA on the R/V <em>K-Hi-C</em></td>
</tr>
<tr>
<td>June</td>
<td>Continue the survey of the Northeast District doing daytrips on the R/V <em>Instar</em></td>
</tr>
<tr>
<td>Aug 5–Aug 15</td>
<td>Complete survey of Afognak District on the R/V <em>K-Hi-C</em></td>
</tr>
<tr>
<td>Oct 20–Nov 31</td>
<td>Process hydroacoustic echograms and generate abundance estimates</td>
</tr>
<tr>
<td>Nov 15–Dec 15</td>
<td>Edit and review underwater video files, generate rockfish species proportions</td>
</tr>
<tr>
<td>Dec 1–Dec 15</td>
<td>Finalize rockfish abundance estimates by district and species</td>
</tr>
<tr>
<td>Dec 20</td>
<td>Rockfish GHL determination meeting</td>
</tr>
</tbody>
</table>

**RESPONSIBILITIES**

<table>
<thead>
<tr>
<th>Personnel</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Philip Tschersich Project FB II</td>
<td>Supervise project, set daily duties while at sea, coordinate data processing and analysis</td>
</tr>
<tr>
<td>Rob Baer, Project FB I</td>
<td>Logistics, equipment installation/maintenance/operation, data collection and analysis</td>
</tr>
<tr>
<td>Dan Wilson</td>
<td>Skipper R/V <em>K-Hi-C</em></td>
</tr>
</tbody>
</table>
REFERENCES CITED


APPENDIX A. ECHOGRAM ANALYSIS USING MYRIAX ECHOVIEW
Appendix A1.–Echogram analysis using Myriax Echoview

Synopsis: targets (echoes) in the recorded echogram are analyzed using Echoview (Myriax, Hobart Australia). Using a set of parameters that are specified by the operator, a series of targets are grouped to represent individual fish. This operation is performed along the length of the echogram until all targets meeting the parameter requirements are included in these groups, or fish ‘tracks.’ Targets below the sea floor are not included in the analysis by identifying the sea floor and turning targets below that bottom line off. The sea floor line is based on the maximum $S_v$ value, which represents the highest volume backscattering strength, with a minimum $S_v$ value set to -70 dB. Because rockfish can be closely associated with structures on the bottom, a backstep of 0 m is used when selecting the bottom line.

In the fish detection algorithm, a 4D data set is used (range, angles, and time). The 4D algorithm is intended for use with split beam data and uses the angular position information of the targets in the beam in addition to the range and time information to accept or reject targets in a series when determining if they will be appended to a track of echoes to define a single fish. To find the track detection properties, choose the menu Echogram > Detect fish tracks, and in the window that opens, select Properties (Figure 1).

Figure 1.

-continued-
The fish detection algorithm uses a 0.8 gain setting for all alpha parameters (major, minor, and range values) and a 0.1 gain for all beta parameters (major, minor, and range). Alpha and beta gain settings influence how sensitive the algorithm is to unpredicted changes in the position or velocity of subsequent targets in a track. A target is considered a candidate for appending to an echo track if it is within a defined geometric shape, or target gate ellipsoid, centered about the predicted location of a track. The exclusion distances from the predicted location along each axis define the gate. Target gates should be set to a 2.0 m distance for the major and minor axis, with a range value of 0.2 m. Missed ping expansion is set to 50% for the major and minor axis, with the range set to 100%. The missed ping expansion assigns an expansion percentage to the gated volume when no targets were assigned to the track from the previous or subsequent pings in the series. No weights are applied to any of the candidate target selection parameters in the algorithm (set in the Weights tab of the Track Detection Properties window). For track acceptance, the minimum number of single targets in an echo track is set to 3 and the minimum number of pings in a track, and maximum gap between single targets, is set to 1 ping (set in the Track Acceptance tab of the Track Detection Properties window).

Once pings are grouped by the algorithm to form echo tracks defining individual fish, the entire echogram should be visually inspected and edited to ensure that the identification algorithm did not include non-rockfish species or bottom features, or failed to include rockfish because of a fish orientation which caused the aggregation of pings to be rejected by the algorithm. This process is outlined below, but requires judgement and experience on the part of the operator and so should be performed by someone familiar with the analysis. The primary output will have two files exported and stored as Microsoft Excel spreadsheets; one containing the count and position (latitude, longitude, and depth) of the detected fish, the second a bathymetric profile (latitude, longitude, and depth) along the vessel track.

**Open Echoview template and import .dt4 data**

1. Navigate to the folder W:\Nearshore\Rockfish_Surveys\EV_Files_2011 and double click the Rockfish_Survey_Template>EV file. You must have Echoview installed and have a license or USB dongle for the program to run.

2. In the Filesets - Rockfish_Survey_Template.EV window, select the Add... button.

3. Navigate to the .dt4 files that make up the echogram. These will be contained in a folder with the name of the district you are analyzing. For instance, 2011 survey data will be in W:\Nearshore\Rockfish_Surveys\DTX_Data_2011 and the files will be in the district folder, such as Shumagins.

-continued-
4. Refer to the logbook that was filled out at the time of the survey to identify which .dt4 files will need to be loaded to comprise the entire echogram for the survey station being analyzed. All .dt4 files are written in 30-minute increments, so a station that took 1 hour and 12 minutes to survey will have 3 .dt4 files associated with it. To open multiple .dt4 files at once, shift-click or ctrl-click each one, then select the button Open. Each .dt4 file name starts with the district, followed by the survey day number, date (yyyy/mm/dd) and finally the time the file began (hh/mm/ss). Groups of .dt4 files that belong together are easy to recognize because their name should end in the same seconds (ss) increment. For instance, all the .dt4 files for the following survey station end in the value 28 (Figure 2):

![Figure 2](image.png)

5. Go to the menu File > Save As... and save a copy of the file in a logical place in a folder you create (e.g., for our Shumagins example, it could be W:\Nearshore\Rockfish_Surveys\EV_Files_2011\Shumagins\Shum_G_11; Figure 3) and give it a consistent, logical name (e.g., Shum_G_11). At this step, make sure you SAVE AS, instead of just saving. You want to create a new file, not overwrite the template file you originally opened.

-continued-
Prepare files and check calibration

1. In the Filesets - Rockfish _Survey_Template.EV window, under Raw Variables, double click the position GPS fixes to open the vessel track plot (Figure 4). Review the plot to determine if the correct files have been selected and that they represent the complete station surveyed. You may need to compare the vessel track in this Echoview window to the route in Coastal Explorer to determine this.
2. Return to the Filesets - Rockfish Survey_Template.EV window, and open the Variable and Geometry window by hitting F7, and then re-size the window so you can see the entire 'org chart' (Figure 5)

![Figure 5](image)

3. Double-click the Transducer1 box to bring up the Transducer Properties window, and select the Calibration tab. Note the Minor and Major axes. They should both read 6.10 (degrees). If not, change them to 6.10.

4. Click OK.

5. Open the Primary Fileset TS view by double clicking the rose-colored box in the 'org chart' called Primary fileset: TS split beam pings (channel 1). Drag the corners so that this fills your screen (Figure 6).

![Figure 6](image)

-continued-
6. Right-click anywhere in the window and select _Variable Properties_ (or hit F8) and select the _Calibration_ tab.

7. Check to make sure the correct _Minor axis_ and _Major axis_ values (i.e., 6.1) for the transducer are being used.

8. Note the values for the _Frequency_. It should be 199.20 kHz. If not, change it.

9. Note the value for the _Transmitted pulse length_. It should be 0.400 ms (Figure 7). If not, change it.

![Figure 7.](image)

10. Click OK.

11. Open the Echoes view by selecting the menu _View > Echogram > echoes_ and then re-size it to match the Primary fileset: TS window.

12. Right-click anywhere in the window and select _Variable Properties_ (or hit F8) and select the _Calibration_ tab.

13. Note the inheritance menu at the top, and set the value to _Inherit calibration settings from: TS split beam pings (channel 1)._
14. Make sure the Inherited values match those seen in the TS view outlined earlier, then click OK (Figure 8).

![Figure 8](image)

**Define the bottom and create a bottom pick line**

1. From the lines tools menu, choose *New Virtual Line* (Figure 9).

![Figure 9](image)

2. Use the *Maximum Sv line pick* under *Operator:*, and then click OK (Figure 10).

-continued-
3. Change the Backstep range (m): value to 0 (zero), and then click OK (Figure 11).

4. A thin green line will appear on the sea floor. The Maximum Sv line pick identifies the maximum backscatter (ping echo) signal volume (or strength: in other words, the most acoustically reflective surface) in the echogram and selects that as the bottom.
5. From the lines tools menu, choose *New Editable Line* (Figure 12).

![Figure 12](image)

5. Under *Destination*, select *Create a new line*: and give it a descriptive name linking it to the station, (e.g., Shum_G_11_Bottom; Figure 13). For *Source*, select *Existing line*: and choose the *Maximum SV line pick 1* from the menu. Check the *Span gaps* and *Make this line active on current echogram* boxes, and then click OK. After a few moments, a thicker green line will overlay the earlier thin virtual line.

![Figure 13](image)

-continued-
7. Scroll along the entire echogram and check to make sure the new editable line has followed the bottom correctly. In areas where the program has difficulty following the bottom (e.g., steep slopes or where the bottom was in excess of 85 m deep and out of the recorded range of the echogram), you may have to make corrections to the line. To do this, select the line tool (Figure 14).

8. Zoom in on the spot that needs fixing. Click on the existing line immediately to the side of the bad section, and then click to create some points defining the new, corrected bottom line, shown below as a dashed line (Figure 15). Press the L key to accept and update the new line path.

![Figure 14](image14.jpg)

![Figure 15](image15.jpg)

**Detect and edit fish tracks**

1. Right-click anywhere in the echoes window and select *Variable Properties* (or hit F8) and select the *Single Target Detection* tab.
2. In the *Exclusion* box, select your new editable line from the pull-down menu where it says *Exclude targets below line:* and then click OK (Figure 16). This will turn all the pings below the bottom pick line off and will ignore those pings during the fish track detection process (Figure 17).

![Figure 16](image1.png)

Figure 16.

![Figure 17](image2.png)

Figure 17.
3. Select the menu item Echogram > Detect Fish Tracks (or hit Ctrl-Shift-K) to bring up the fish track detection window.

4. In the Detect Fish Tracks (Echogram) window, click on the Properties button. Under the Algorithm tab, you should see the following values in the various fields (Figure 18). It is not necessary to open this properties window each time you detect fish tracks, but it is a good policy to check to make sure the calibration EV file you first opened is using the correct detection values once per processing session (once per day). Confirm the values and click OK.

![Track Detection Properties](image)

Figure 18.

-continued-
5. Back in the *Detect Fish Tracks* window, click the Detect button. The program will work for a period and will then draw a colored border around groups of pings it considers belonging to a single rockfish (i.e., a *fish track*), and indicate this with "(Rockfish)" next to each fish track (Figure 19).

6. Right-click anywhere in the echoes window and select *Variable Properties* (or hit F8) and select the *Single Target Detection* tab.

7. In the *Exclusion* box, select *None* from the pull-down menu where it says *Exclude targets below line:* and then click OK. This will turn all pings below your bottom pick line back on.

8. You will now zoom in and scroll down the length of the echogram and manually identify groups of pings that belong to a rockfish that the algorithm missed, or deselect fish tracks that are unlikely to represent actual rockfish. *The process of creating or deleting fish tracks should follow a set of guidelines consistent between researchers working on this project. Discuss the level of intervention that is considered standard with your supervisor.* As a general rule and for consistency's sake, it makes sense to allow the fish track selection that the algorithm makes to stand and not bias the analysis with an individual researcher's tendency to add or delete fish tracks. Because data derived from this project produces an abundance index, the results should be comparable from year to year irrespective to who processed the echograms.

9. Click on the Fish track edit button in the toolbar. Click in the echogram where you want to zoom in or out, and then use your mouse scroll wheel to zoom.

-continued-
10. Once you have a clear view of the echoes you want to edit, draw a box around the pings to be modified and right click anywhere. From the contextual menu that appears you can select *Delete Fish Tracks* (or press Ctrl-X), or select *Create Fish Track from targets*. You can select large regions of pings and delete all the fish tracks in the selected area at once, but the command to create a fish track requires selecting a discrete group of pings that represent a single fish.

11. Two main areas that deserve special scrutiny are along the sea floor, and high up in the water column. If echoes that are part of the bottom fall above the bottom line pick, they are likely to be grouped into fish tracks. Despite the fact that the algorithm uses backscatter strength to identify targets, you can use color to discern fish near the bottom from actual bottom. Greens, yellows, oranges, and reds are unlikely to represent rockfish and when near the sea floor should be deselected (Figure 20).

12. Sometimes it can be difficult to interpret the view that the echoes window represents because it is "filtered" (shows a higher dB threshold value) compared to what would be seen in Visual Acquisition when originally recording the echogram. Pressing the A key on the keyboard synchronizes the echoes window with the primary fileset TS view window. Switching to the TS view can offer a more familiar view of the echogram and aid in decisions of whether or not to delete fish tracks. Consider the two windows below (Figure 21). It is unclear in the echoes view if the echoes represent rockfish or not, while in the TS view it becomes clear that the main aggregation of echoes is a school of feed such as krill while the smaller series of pings above and to the right of the feed are probably rockfish. In this instance, the large cloud of pings in the lower left would be selected and fish tracks in that region deleted.

---continued---
13. A good strategy is to zoom in to the point where individual fish are visible and to scroll down the entire length of the echogram following the bottom and verify the data quality along the way. When you reach the end of the echogram, scroll back to the beginning while scrutinizing the echoes near the water surface. Rockfish generally do not occupy the upper 20 m of the water column and most echoes designated as fish tracks in this depth region are bubbles from the vessel and diving birds, or feeder fish and can be deleted. Consider the following examples where the first is the echoes view, and the second the TS fileset (Figure 22). In the TS fileset view, the vertical column in the center can be identified as bubbles from a diving bird and the fish track indicated among the echoes is probably spurious. There probably is not enough evidence to overturn the fish track in the lower left.
Export fish tracks and bottom line

1. Save your work. Make sure you are saving to the EV file you created for the survey station earlier and are not overwriting the template file.

2. Make sure you are in the Echoes window, and then select the menu item *Echogram > Export > Analysis By Regions > Fish Tracks* and then in the export window click *Export*.

3. Select a destination and file name. The file should be named something logical and consistent (e.g., `Shum_G_11_Fish.csv`) and be saved to the same folder where the survey station's EV file is saved (e.g., `W:\Nearshore\Rockfish_Surveys\EV_Files_2011\Shumagins\Shum_G_11`).

4. Next export the bottom pick line. Select the menu item *Echogram > Export > Line...* and then select your bottom line from the *Line:* pull down menu, select CSV as the file format, and click *Export.*

-continued-
5. As with the fish export, save the file into the same folder containing the station's EV file and give it a logical and consistent name (e.g., Shum_G_11_Bottom.csv) and then click OK.

6. Congratulations, you are finished and can close Echoview. To start the next station, reopen the template file and begin the process over again.
APPENDIX B. STATISTICAL EXPANSION OF HYDROACOUSTICALLY-DERIVED FISH COUNTS
Echograms are continuously recorded along the entire cruise track of each survey station. However, only data recorded from delineated transects crossing a survey area are included in fish density analyses; data from echograms representing the vessel’s transit between the end of one transect and the beginning of the next transect are excluded. There are three variables of interest in the analyses of the rockfish aggregations from each transect’s fish and bathymetric data files: latitude, longitude, and depth. Individual transects within a survey station (grid or star) are treated as simple line transects with perfect detection of fish assumed within the acoustic beam.

From the bathymetric data, bottom pings for individual transects are delineated by plotting the cruise track and selecting latitudes and longitudes for each transect’s beginning and ending points. This and subsequent tasks are performed using Minitab 15 statistical software (Minitab Inc, State College PA). The locations of fish detections are also plotted and included in the analyses when they fall between transect endpoints. The bathymetry data for an individual transect consists of 1,000 to 9,000 individual bottom-ping records (latitude, longitude, and depth) depending on transect length and vessel speed, or one record about every 1 m of transect length, much closer together than the precision of the GPS instrumentation. In order to make the volume of data more tractable, the bathymetric data is reduced by systematically selecting every 20th ping between the transect endpoints. The resulting data are used to determine point to point transect lengths (km).

The fish location data will be analyzed in the following way. Since the acoustic beam of the Biosonics DTX transducer is a 6.2° cone, the effective width of a transect increases by approximately 0.11 m for each 1 m increase in depth. To account for increased beam width with depth, a method described by Yule (2000) is employed. The procedure deals with fish individually and, accounting for the increase in transect width with depth, each fish is standardized to a 1 m wide transect. For a single fish at depth $z$ from a transect of length $l$, its standardized contribution to the transect density can be expressed by

$$ density = \left( \frac{1}{0.11 \times z} \right) / l. $$  \hspace{1cm} (1)

The total fish density for a transect is the sum of the contributions of all fish detected by the acoustic beam standardized to a 1 m wide transect. That is, for transect $i$ where $f_i$ fish were detected at depths $z_h$ ($h=1, \ldots, f_i$), the density $d_i$ is calculated as follows.

$$ d_i = \frac{1}{l_i} \sum_{h=1}^{f_i} \frac{1}{0.11 \times z_h} $$  \hspace{1cm} (2)
The mean density estimate for each station is calculated using standard statistical formulas for mean and standard error. That is, for \( n \) transects sampled each with density estimate \( d_i \), the estimated mean density \( \bar{d} \) for a survey station is

\[
\bar{d} = \frac{1}{n} \sum_{i=1}^{n} d_i , \quad (3)
\]

\[
SE(\bar{d}) = \sqrt{\frac{\sum_{i=1}^{n} (d_i - \bar{d})^2}{n(n-1)}} . \quad (4)
\]

The estimated rockfish population for a station is the product of the estimated mean station density and the station area (km\(^2\)). Each survey station’s area is calculated using the transect endpoints to create a polygon, and using Minitab macros to calculate the area of the polygon. The standard error for the estimated rockfish population is the square root of the product of the station area squared and the variance of the estimated mean station density, where the variance is the square of the standard error.

\[
\text{population} = \bar{d} \times \text{(station area)} \quad (5)
\]

\[
SE(\text{population}) = \sqrt{(\text{station area})^2 \times SE(\bar{d})^2} \quad (6)
\]

Calculating the estimated density and its standard error for a single species within a station is similar. For example, a station where \( p_b \) is the estimated proportion of black rockfish, the estimated density of black rockfish is the product of the proportion and the estimated station density. The standard error of the estimated black rockfish density is the square root of the product of the proportion squared and the variance for the mean station density.

\[
\bar{d}_b = p_b \times \bar{d} \quad (7)
\]

\[
SE(\bar{d}_b) = \sqrt{(p_b)^2 \times SE(\bar{d})^2} \quad (8)
\]

District totals are calculated by summing the individual station estimates, and the variance is calculated using a standard pooled variance formula.

\[
s_p^2 = \frac{\sum_{i=1}^{k}(n_i - 1)s_i^2}{\sum_{i=1}^{k}(n_i - 1)} \quad (9)
\]
Based on simulation studies (D. Barnard, Region IV Biometrician, Kodiak, AK, unpublished manuscript), the methods described above provide unbiased density estimates for data collected from grid-pattern surveys, but produce biased estimates from the star-pattern survey data. The star-pattern design, used by studies of tuna concentrations associated with fish-aggregation devices in the Pacific Ocean (Josse et al. 1999)\(^1\), was adopted because of its better relative efficiency for coverage of rockfish schools associated with pinnacles. While the acquisition of the acoustic data in the tuna studies was similar to the rockfish study, the goals of the rockfish study were different; hence alternate data-analysis methods were required. The density estimator used for grid-pattern sampling was not wholly appropriate for the star-pattern sampling due to a station’s transects all crossing near to a common center (where rockfish are aggregated), thereby increasing the probability of fish near the center of the star pattern being sampled relative to fish further from the center. The simulation work confirmed this bias and provided a model of the sampling probability which was used to adjust a fish’s contribution to the density based on its distance from the center of the star-pattern center. Previously, a fish’s contribution to the density of a 1 m wide transect was a function of its depth based on the geometry of the acoustic cone. Similarly, the star-pattern method required additional weighting in the data analysis based on a linear relationship between the inverse of the sampling probability of each fish relative to its distance from the center of a star-pattern station as estimated by the simulation analysis. First, the star-pattern center was defined as the means of the transect-endpoint latitudes and longitudes. Then the distance of each fish to the star-pattern center was expressed as a proportion of the maximum distance from the star center to the transect endpoints. For a fish at depth \(z\) meters that is \(g\) meters from the center of a star-pattern station where \(k\) meters is the (maximum) distance from the star center to the furthest transect endpoint, then contribution of that fish to the transect density is

\[
\text{density} = \left[ \frac{1}{0.11 \times z} / l \right] \times \left[ 0.0048 + 2.26 \times \left( \frac{g}{k} \right) \right]. \quad (10)
\]

The right-hand part adjusts for its distance from the center of the star-pattern. Once the adjustment is made, unbiased density estimates can be easily obtained. Transect densities for star-pattern stations use the same mean and standard error formulae described above (equations 3 and 4).

\(^1\)Josse, E., A. Bertrand, and L. Dagorn. 1999. An acoustic approach to study tuna aggregated around fish aggregating devices in French Polynesia: methods and validation. Aquatic Living Resources. 12(5): 303-313
APPENDIX C. PROCESSING HYDROACOUSTICALLY-DERIVED FISH LOCATIONS AND BATHYMETRY IN MINITAB
Appendix C1—Processing the hydroacoustically derived fish locations and bottom soundings in Minitab.

After processing the hydroacoustic echogram in Echoview, the resulting .csv files representing the latitude, longitude, and depth of each fish, and the latitude, longitude, and depth of each bathymetric point, are used in Minitab to generate density estimates for rockfish in the survey station.

**Prepare the .csv data for Minitab**

1. Prepare the .csv spreadsheets exported from Echoview for use in Minitab. Open both the fish and bottom spreadsheets in Excel by Navigating to the folder W:\Nearshore\Rockfish_Surveys\EV_Files_20XX.

2. In the sheet containing the fish data, delete columns A through G (Region_ID through Date_S) and also columns K through S (Standard_deviation through Time_in_beam). You will have 4 columns remaining; Time_S, Lat_S, Lon_S, and Target_depth_mean.

3. The value -9999 is the code for bad depth data and instances of this value need to be identified and corrected (Figure 1). Hold down the Ctrl key and press F which will bring up the search function, type in the value -9999, and click Find Next (or the enter key). The first instance of the value -9999 will be highlighted (if there are any). Click once in the cell with the -9999 value and hold down the Ctrl key and press D. This will copy the value from the cell above the bad cell into the bad cell. Select Find Next again and repeat this process until no more cells with -9999 are found, and then close the Find window.

4. Highlight column A (Time_S) and sort the column alphabetically (chronologically). If Excel asks you if you want to expand the selection to all the data, say yes. Verify that the rows of data are in chronological order. Echoview sometimes exports the fish position data out of order which makes the work in Minitab impossible.

5. After sorting chronologically, delete column A (Time_S). You now have 3 remaining columns; Lat_S, Lon_S, and Target_depth_mean.

-continued-
6. In cell D2 (the first data cell to the right of the Depth column), enter the formula =(-1)*C2. Copy this formula all the way down the data set in column D. This converts the positive depth values in column C into negative numbers in column D.

7. Right click in the head of column D and select Copy from the contextual menu, and then right click in the head of column C and select Paste Special. Under Paste, double click on Values. This overwrites the contents of column C with the negative depth values.

8. Delete column D (which will now have positive values).

9. Highlight all 3 columns and then right click and select the contextual menu item Format Cells.

10. Under Category: select Number and set the decimal places to 5, then click OK.

11. Change the column names to flat, flon, and fz (for "fish lat", "fish lon", and "fish depth"; Figure 2).

12. Choose the menu item File > Save As... and save the file as an Excel Workbook (.xls or .xlsx) in the same folder as where the associated .csv and EV files are saved. Give it a logical and consistent name (or simply accept the default name which is the same as the .csv file if that is appropriate).

13. In the sheet containing the bottom data, delete columns A through C (Ping_date through Ping_milliseconds), column F (Position_status), and columns H through K (Line_status through GPS.UTC_time). You will have 3 columns remaining; Latitude, Longitude, and Depth.

-continued-
14. In cell D2 (the first data cell to the right of the **Depth** column), enter the formula \( =(-1) \times C2 \). Copy this formula all the way down the data set in column D. This converts the positive depth values in column C into negative numbers in column D.

15. Right-click in the head of column D and select **Copy** from the contextual menu, and then right click in the head of column C and select **Paste Special**.... Under **Paste**, double click on **Values**.

16. Delete column D (which will now have positive values).

17. Highlight all 3 columns and then right-click and select the contextual menu item **Format Cells**....

18. Under **Category**: select **Number** and set the decimal places to 5, then click OK.

19. Make sure the column names are **Latitude**, **Longitude**, and **Depth** (Figure 3)

20. Choose the menu item **File > Save As** and save the file as an Excel Workbook (.xls or .xlsx) in the same folder as where the associated .csv and EV files are saved. Give it a logical and consistent name (or simply accept the default name which is the same as the csv file if that is appropriate).

---

**Figure 3.**
Open and prepare Minitab template for data

1. The processing of grids and stars differs in a few critical aspects, and so they will be presented separately when appropriate. Both station types share the same basic early processing steps, however, and a grid will be used as an example. Navigate to the folder \W:\Nearshore\Rockfish_Surveys\MinitabAnalysis. In that directory there are a number of folders named for the year of the survey. Open the appropriate year and notice two folders named _Minitab Grid Template and _Minitab Star Template. Use the template appropriate for your station.

2. Open the appropriate Grid/Star folder and double-click on the file ending in the suffix .MPJ (Minitab Project). A window looking like the one below should appear (Figure 4). The Minitab project is made up of multiple worksheets that can be viewed simultaneously. Each worksheet serves a different purpose described later, but for clarity they are labeled in the diagram below. The star template only differs in the transect summaries sheet in that it has a few extra columns for data.

![Figure 4.](image)

3. Select the menu item File > Save Project As. Navigate to the District folder you are working in, click the make new folder icon, and give the folder a logical name (e.g., Shum_G_11). Open the new folder and save your Minitab project with a logical name (e.g., Shum_Grid_11).

-continued-
4. Select the menu item **File > Save Project As.** Navigate to the District folder you are working in, click the make new folder icon, and give the folder a logical name (e.g., Shum_G_11). Open the new folder and save your Minitab project with a logical name (e.g., Shum_Grid_11).

5. Minitab worksheets are saved separately from the overall project, so you will need to save each one individually the first time. Activate a worksheet by clicking in it (the active window has three asterisks after the name in the header), and then select the menu item **File > Save Worksheet As.** Give it an appropriate name to make sure it ends up in your project folder and not the template folder. Do this for each sheet, so you will do the **Save Worksheet As** step 5 times. Once each worksheet is saved into the project folder, saving the project will also save all the sheets so you only have to do these multiple steps when you first create the project.

6. Copy the 3 columns of data out of the bottom data Excel spreadsheet and paste into the bathymetry Minitab worksheet (labeled "Bathymetric Data" in the diagram above). Make sure the entire columns are copied and pasted across and verify that the upper rows of the columns have values and not asterisks *.

7. Copy the 3 columns of data out of the fish data Excel spreadsheet and paste into the bathymetry Minitab worksheet (labeled "Bathymetric Data" in the diagram above) to the right of the bottom data you just pasted in, leaving a blank column between the data sets. Make sure the entire columns are copied and pasted across and verify that the upper rows of the columns have values and not asterisks *.
8. Copy the 3 columns of data out of the fish data Excel spreadsheet again and paste into the fish Minitab worksheet (labeled "Fish Data" in Figure 4). Make sure the entire columns are copied and pasted across and verify that the upper rows of the columns have values and not asterisks * (Figure 5). Save your work by selecting the menu item File > Save Project (or hit Ctrl-S).

![Minitab Worksheet](image)

Figure 5.

**Plot the data and gather transect information**

1. Make the Bathymetric Data sheet active, and then select the menu item Graph > Scatterplot, then choose Simple, and click OK.

2. Add data to the plot by double clicking on the column names C1 Latitude and C2 Longitude in the left-hand field of the Scatterplot - Simple window. They will appear in the list on the right as you add them. Click OK. The bottom line data points should plot in a new window.

3. Resize the scatterplot window so that it fills the screen, but so that the Transect Endpoint Window is still visible in the lower left. Click on the scatterplot title text and delete it. Do the same with the symbol legend. You can now click and drag the corners of the plot area to fill the window (the axes and such will be hidden by the edge of the window- they are not necessary). You need to maximize the amount of space in the scatterplot itself in order to more easily identify specific plot points.

-continued-
4. The bottom is plotted as large red circles. In order to change the symbols, click once on one of the red bottom points on the plot (this selects ALL the points), and then right-click and select *Edit Symbols* (or hit Ctrl-T). In the Edit Symbols window, select the *Custom* radio button and scroll to the bottom of the list and select the small point, and then click OK (Figure 6). The plot will change to a thinner, red line.

![Figure 6](image)

5. Make sure the scatterplot window is active and then hover one end of the vessel track with the mouse and wait for a small label to appear that indicates information about that point in the plot. You want to identify which end of the track is the start, indicated by the row number being 1 (Figure 7). This value should be typed into the Transect Endpoint Window under *Z Start*.

![Figure 7](image)

-continued-
6. Move to the end of the first straight transect to the point where the vessel begins its turn towards the second leg, and hover over the end of the straight portion to find the row number corresponding to that point (Figure 8). In the example below, the row number is 811. This value should be typed into the Transect Endpoint Window under Z End.

7. Continue to do this for every transect placing each beginning and ending value for a transect on its own row in the Transect Endpoint worksheet until you have done this for all transects (Figure 9).
8. Now plot the fish locations in relation to the bottom. Minimize the bottom point scatter plot to move it out of the way. Make sure the Bathymetric Data window is active (click in the title bar if necessary) and again select the menu item Graph > Scatterplot, then choose Simple, and click OK.

9. Add data to the plot by double clicking on the column names in the left-hand field of the Scatterplot - Simple window. They will appear in the list on the right as you add them. Add C1 Latitude, C2 Longitude, C5 flat, and C6 flon. Then click on the button called Multiple Graphs... and select the radio button Overlaid on the same graph, and then click OK in that new window, and also OK in the original Scatterplot window (Figure 10). The bathymetric data points and the fish locations should plot in a new window.

10. The bottom soundings will probably appear as black circles and the fish as red squares on the new plot. Resize the scatterplot window so that it fills the screen, but so that the Transect Endpoint Window is still visible on the lower left. Click on the scatterplot title text and delete it. Do the same with the symbol legend. You can now click and drag the corners of the plot area to fill the window (the axes and such will be hidden by the edge of the window - they are not necessary). You need to maximize the amount of space in the scatterplot itself in order to more easily identify specific plot points.
11. Next change the symbology. Since both data series are now plotted in the same window, you need to click on the plot once to select all the symbols, and then click a second time to select just the data series you want to effect (bottom soundings or fish). To change the bottom sounding symbols, click once on a black bottom symbol, then click on it again, and then right click and select Edit Symbols (or hit Ctrl-T). Select the custom symbol of the small black point and click OK.

12. To change the fish symbols, click once on a red fish symbol, then click on it again, and then right click and select Edit Symbols (or hit Ctrl-T). Select the custom symbol of the thin + or X and click OK (Figure 11).

![Figure 11.](image)

13. You will now get the starting and ending row number for the fish in each transect much like you did for the bottom soundings. These will be entered in the Transect Endpoint window under the F Start and F End columns. The first fish in the transect should be located beyond the bottom sounding that designates the first point (row number) of the transect, and the last fish in the transect should fall before the last bottom sounding designating the transect. In other words, the fish associated with the transect must fall within the starting and ending points chosen to designate that transect.
Note: There are times when the fish symbols mask the bottom soundings due to their larger size, and it is difficult to determine where the fish symbol is relative to a specific bottom sounding. It may be necessary to zoom in on the scatterplot or to make the fish symbols small points in these cases. If it becomes necessary to zoom in on a particular portion of the plot to see the points more clearly, you can use the zoom tool and specify the amount of magnification you would like up to 500% and then scroll around the plot area. There are times when fish occur in corners or over portions of the bottom plot where you are trying to identify a bottom value, and because the fish are superimposed over the bottom plot only the fish value pops up. At these times, it is easiest to temporarily change the symbol of the fish to a small point like the bottom plot, get the bottom value needed, and then change the fish symbol back to the X (Figure 12).

![Figure 12.](image)

**Grid stations: determining fish density for each transect**

1. If your station is a grid, continue on with these instructions. If your station is a star, jump down to the procedure for star pattern stations.

2. Minimize (but do not delete) the scatterplot. It will become a tab in the lower left-hand corner of the window. Save the project. You will next copy and paste the appropriate rows of fish and bottom data into individual worksheets and process each transect separately. The row starting and ending information you just collected from the scatterplot will make this possible.
3. Note the starting row for the transect 1 bottom data. In this example, the row is 1. Click in column C1, row 1 of the bathymetric data worksheet. Scroll down the sheet until you find the row that corresponds to the end of transect 1, in this case, row 820. Note that if you grab the scroll handle on the right side of the worksheet, as you slide it down a prompt pops up and tells you which row you are positioned near (Figure 13). This is extremely useful and will help you find the ending row easily.

4. Hold down the Shift key, and click in the last cell containing the desired data: in this case, row 820 in column C3. Copy the data to the clipboard, and paste it into the first 3 columns (C1-C3) of the transect worksheet.

5. Now go to the fish worksheet, and select the rows of fish corresponding to transect 1. In this case, you would copy rows 1 through 230. Paste those in columns C9 - C11 of the transect worksheet. (Note that these are NOT the next 3 labeled columns in the sheet; Figure 14).

Figure 13.

Figure 14.

-continued-
6. The next step is to run a macro which will reduce the depth data. It will take every 20th value from the bottom dataset, and place it in rows in columns C5-C7 (the ones labeled rlat, rlon, and rz; "r" stands for reduced; Figure 15). To run the macro, click in the Session window, and at the MTB > prompt, type `%tranbath c1-c3 c5-c7` and then hit return. The macro will run and populate the reduced data columns.

![Macro output](image1.png)

Figure 15.

7. The next macro will calculate the length of the transect and the density of fish in that transect. In the Session window, at the MTB > prompt, type `%astrden c5 c6 c11 c13 c14` and then hit return. The macro will run and populate the c13 and c14 columns of the transect worksheet with the transect length and fish density respectively.

-continued-
8. Copy the transect length and fish density values and paste them into the first row of the transect summary worksheet (Figure 16).

![Figure 16.](image)

9. Save your work (Ctrl-S) and then minimize the transect worksheet you have been using.

10. Create a new worksheet by selecting the menu item *File > New* (or hit Ctrl-N) and move it so it occupies the space left when you minimized the first transect worksheet. Label the column headings in the same way as the previous transect worksheet (copy and paste or run an X-keys macro).
11. Select the menu item File > Save Current Worksheet... and give it the same name as the first worksheet, but advance the numeric value following the 'T' by one. So this worksheet would be called Shum_G_11_T02.MTW (Figure 17).

![Save Worksheet As dialog box](image)

**Figure 17.**

12. At this point you will repeat the steps 1-10 in this section for each transect. Copy and paste the bottom and fish rows of data and paste into new transect worksheets, run the macros, and paste the transect length and fish density values into the transect summary sheet.

-continued-
13. With the transect summary window active, type the following at the MTB > prompt in the Session window: `%gridstdam c1 c2 c4 c5 c6`. This will calculate the mean density of fish from all transects, the SE of that mean, and the CV (Figure 18).

![Image](image.png)

Figure 18.

**Star stations: determining fish density for each transect**

1. If your station is a star, continue on with these instructions. If your station is a grid, jump back up to the procedure for grid pattern stations.

2. Next copy and paste the appropriate rows of fish and bottom data into individual worksheets and process each transect separately. The row starting and ending information you just collected from the scatterplot will make this possible.

-continued-
3. Note the starting row for the transect 1 bottom data. In this example, the row is 1. Click in column C1, row 1 of the bathymetric data worksheet. Scroll down the sheet until you find the row that corresponds to the end of transect 1, in this case, row 820 (Figure 19). Note that if you grab the scroll handle on the right side of the worksheet, as you slide it down a prompt pops up and tells you which row you are positioned near. This is extremely useful and will help you find the ending row easily.

4. Hold down the Shift key, and click in the last cell containing the desired data: in this case, row 820 in column C3. Copy the data to the clipboard, and paste it into the first 3 columns (C1-C3) of the transect worksheet.
5. Now go to the fish worksheet, and select the rows of fish corresponding to transect 1. In this case, you would copy rows 1 through 230. Paste those in columns C9-C11 of the transect worksheet. (Note that these are NOT the next 3 labeled columns in the sheet; Figure 20).

![Figure 20](image.png)

6. The next step is to run a macro which will reduce the depth data. It will take every 20th value from the bottom dataset, and place it in rows in columns C5-C7 (the ones labeled rlat, rlon, and rz; "r" stands for reduced). To run the macro, click in the Session window, and at the MTB > prompt, type %tranbath c1-c3 c5-c7 and then hit return (Figure 21). The macro will run and populate the reduced data columns.

![Figure 21](image.png)

-continued-
7. The next macro will find the lat and long of the transect endpoints and calculate the length of the transect. In the Session window, at the **MTB >** prompt, type `%startran1 c5-c6 c13-c15` and then hit return. The macro will run and populate the C13-C15 columns of the transect worksheet with the transect endpoint coordinates and the transect length.

8. Copy the transect endpoint coordinates and paste them into the first 2 rows of the transect summary worksheet next to the `Start` and `End` labels (Figure 22).

9. Save your work (Ctrl-S) and then minimize the transect worksheet you have been using.

10. Create a new worksheet by selecting the menu item **File > New** (or hit Ctrl-N) and move it so it occupies the space left when you minimized the first transect worksheet. Label the column headings in the same way as the previous transect worksheet (copy and paste or run an X-keys macro).

11. Select the menu item **File > Save Current Worksheet...** and give it the same name as the first worksheet, but advance the numeric value following the 'T' by one. So this worksheet would be called `Shum_S_04_T02.MT` (Figure 23).

-continued-
12. At this point you will repeat steps 2-11 in this section for each transect. Copy and paste the bottom and fish rows of data and paste into new transect worksheets, run the macros, and paste the transect endpoints into the transect summary sheet. Almost all stars have 5 transect legs, so you will have 5 sets of starting and ending coordinates (Figure 24).

13. The next macro will find the geographic center of the station. Click in the transect summary sheet where you pasted the transect endpoint coordinates to make that window active (denoted by the 3 asterisks * after the name), then click in the Session window and at the MTB > prompt type %starsum1 c3 c4 c6-c8 and then hit return. The mean lat and lon (the center), and the maximum distance from the transect endpoints to the center of the star are calculated (mlat, mlon, and md2c, respectively). 

-continued-
14. Copy the values under \textit{mlat}, \textit{mlon}, and \textit{md2c} in the transect summary window to the corresponding columns in the individual transect worksheets. You will need to copy these values onto all 5 transect worksheets (Figure 25). These values will be used by the macro in the next step.

![Figure 25.](image)

15. Make sure a transect worksheet is active (you will work on all 5, but the order is not important), then click in the Session window and at the \textit{MTB >} prompt type \texttt{%startran2 c9-c11 c16-c18 c15 c20} and then hit return. The macro will calculate the adjusted fish density based on the fish locations (lat, long, and depth), the mean location of the star (\textit{mlat} and \textit{mlon}), each fish's distance from the center of the star (\textit{md2c}), and the transect length (\textit{trl}). The output, fish density (\textit{dens}), appears in column C20 (Figure 26).

![Figure 26.](image)
16. Copy the value for the transect density from the transect worksheet and paste it next to the appropriate transect number in the transect summary worksheet in column C11.

17. Repeat the previous 5 steps for each transect until you have all of the density values entered in column C11 of the transect summary sheet.

18. For the final step, make sure the transect summary sheet is active and then at the MTB > prompt in the session window, type %starsum2 c11 c12-c14 and then hit return. The individual transect densities are combined to give an overall mean estimated fish density (md), a standard error (se), and a coefficient of variation (cv) for the star pattern survey station (Figure 27).

Figure 27.

Calculate the station area for grids and stars

1. Create a new window

2. Label the columns tr, blat, blon, elat, elon, ta, tsa

3. Number the rows under tr with the number of transects (1, 2, 3... etc.)

4. Paste the transect start and end points (lat and lon) from each transect worksheet under the appropriate columns. E.g., blat refers to the beginning latitude while elon refers to the ending longitude, etc.

5. In the session window, type "%gridarea c1-c5 c6 c7" for grids or "%stararea c1-c5 c6 c7" for stars, and hit return

6. The calculated station area will appear in the tsa column
APPENDIX D. USE OF THE NAUTICAL CHARTING PROGRAM COASTAL EXPLORER 2009
Appendix D1.–Drawing Grid and Star Survey Routes in Coastal Explorer 2009

To draw a route in the program Coastal Explorer 2009, select the menu item *Insert > Route* (or hit F8). The arrow cursor will show a small plus (+) sign next to it, and clicking once at the desired start location will place a mark at that spot. As the cursor is moved away from the first mark a straight dashed line trails behind with the bearing and range indicated above and below the line, respectively, and projection and tangent lines are shown in magenta. Additional clicks place more waypoints sequentially on the route. Use the bearing and range values to align and determine the spacing of the route’s legs. The transects of a grid may be of any length, but neighboring transects should be spaced 50 meters apart (Figure 1). Double clicking will end the route, and individual marks along the route can be clicked and dragged to new locations in order to modify the route’s shape. If the program is not showing distances in metric units, select menu *Tools > Options*, and under *Category* select *Measurements*.

Figure 1.
Drawing a star is the same general process; however, it can be useful to begin by drawing a circle to help guide the placement of vertices of the pattern. Select the menu item Insert > Boundary Circle and click at the point where you want the center of the star to reside. A circle of approximately 0.5 km will appear. Make sure the Properties are visible in the Task Pane by clicking on Properties along the right-hand margin of the window. With the circle still selected (if not, click anywhere along the red edge of the circle) in the Properties window under Icon: select any shape other than “none.” A mark you have specified will now appear at the center of the circle. If you hover over the circle’s edge, the hand cursor will have a four-way direction arrow next to it indicating that clicking and dragging will change the diameter of the circle. You will want to change the diameter of the circle to 0.3 km. To draw the star, select menu item Insert > Route (or hit F8) and begin to add points (Figure 2). Imagine the circle as a clock face. It is easiest to begin at the top of the circle at 12 o’clock and draw the first leg down to the bottom of the circle at 6 o’clock (so that the center mark icon you added falls along the line). Each click of the mouse will add a waypoint to the route you are drawing. The next mark should be placed approximately between 4 and 5 o’clock, and then extend the line across to the opposite side of the circle to between 10 and 11 o’clock (again, so that the center mark you placed falls along the line). Next click between 9 and 10 o’clock and extend the line horizontally across to between 3 and 4 o’clock. The next leg will run from between 2 and 3 o’clock down to between 8 and 9 o’clock, and the final leg from between 7 and 8 o’clock to between 12 and 1 o’clock. Double-click or right-click to finish.

Figure 2.
Once the route has been drawn, the appearance of the route can be changed by selection options in the Properties area such as changing the route waypoint style, the route color, displaying direction arrows, displaying leg ranges and bearings, etc. It is also important to name any object you create. Stations generally follow the naming convention of an abbreviation of the district (e.g., NE for Northeast District) followed by either “Grid” or “Star”, and then the next number in a numerical sequence for that district (i.e., NE Grid 12 would be then next created after NE Grid 11). Marks indicating fish concentrations in a grid or star should be similarly named. Occasionally save the file navigation objects to the hard drive by selecting menu File > Save.
APPENDIX E. SETUP AND USE OF THE HYDROACOUSTIC SYSTEM
Appendix E1.—Configuration of the Biosonics hydroacoustic transducer, cable, DT-X controller, GPS, and computer.

The Biosonics DT-X system collects data from a number of components and sends that data to a computer for visualizing and recording. Hydroacoustic information is collected by the echosounder’s transducer while spatial information is collected via a GPS antenna, and the resulting spatially and temporally correlated echogram is displayed by the program Visual Acquisition. This appendix describes how to connect the hardware required for hydroacoustics using the Biosonics DT-X system.

A number of components will be assembled to collect the hydroacoustic and position data. A GPS receiver antenna (Figure 1) is mounted in a high location on the vessel with an unobstructed view of the sky, and the cable is routed into the vessel’s cabin to the Biosonics DT-X surface unit housed in a Pelican case.

![Figure 1.](image)

The hydroacoustic transducer (shown below, left) is mounted on a tow sled or on the end of a pole attached to the vessel’s gunnel, with the transducer face 1 m below the water surface. The rubber-coated ceramic face (Figure 2) is extremely sensitive and must not be damaged in any way. Oils and other products should not be allowed to come in contact with the transducer face as these will change the acoustic interface with the water and provide inaccurate data. The transducer data cable (Figure 2) is attached via a waterproof connector to the transducer. Silicone dielectric grease or an electronics-safe water dispersion spray lubricant such as silicone or Corrosion Block (Midwest Corrosion Products, Lansing MI) should be used inside the plug interface. The outside of the connection can be wrapped in electrical tape for extended deployments such as when mounted on the transducer pole. The end of the transducer cable with the green metal military-style connector is routed into the vessel’s cabin to the Biosonics DT-X surface unit.
The Biosonics DT-X surface unit (Figure 3) is placed on a flat surface using restraints or a grip pad, in a dry location on the vessel, where it is not in danger of a fall or splashing in heavy seas.

On the back and side panels of the Biosonics DT-X control module Pelican case are a number of military-spec waterproof electronics plugs. All the cables that will attach to these plugs are unique so there is no danger of attaching the wrong cable to a plug. The four connections (Figure 4) that will be made to the DT-X Pelican case are:

-continued-
- 110v AC cable to power supply
- GPS data cable to GPS receiver
- Echosounder data cable to transducer
- Ethernet cable to computer

Figure 4.

All military-spec connectors should be fully seated with the threaded collar turned fully clockwise to tighten, and then backed off a quarter turn. It is not necessary or desirable to have these connectors made overly tight. The Ethernet cable from the Biosonics DT-X surface unit is connected to the Ethernet port on a computer. The serial connection can be used to send a GPS NMEA data stream to another program in the computer if that becomes necessary.

The hydroacoustic transducer **must be in the water** before pinging is initiated or else the ceramic element may be permanently damaged. The hydroacoustic echogram can be viewed whenever the transducer is in the water without actually logging (recording) the data to the computer hard drive. The vessel operator should maintain a speed of about four knots during the duration of logging the echogram. When not actively logging the echogram, the vessel can be operated at up to eight knots before turbulence across the transducer face introduces noise on the echogram when using the transducer mounted on the pole. The sled-mounted transducer should never be towed faster than five knots as the sled tends to rise in the water column at higher speeds.
Appendix E2.—Use of Biosonic’s Visual Acquisition to record and view the hydroacoustic echogram.

The interface used to view and log the echogram created by the hydroacoustic system is a program called Visual Acquisition (Figure 1). It uses a real-time, side-scroll view to display the echogram much like a shipboard downsounder. In the program, the operator can set the environmental parameters such as water temperature and salinity (which affect the speed of sound in water), file naming and recording protocols for logging the echogram, and many other settings which affect how the echogram is viewed and what data is logged.

Figure 1.

Outlined below are the specific steps used to initialize, view, log, and shut down the Visual Acquisition environment. More comprehensive information about the program can be found in Appendix J3. The hydroacoustic transceiver MUST be submerged in water before pinging can be initiated or irreparable damage will occur to the ceramic element in the unit.

Before initializing the system, a temperature and salinity reading of the water should be taken using the YSI 30 sensor (Figure 2). Press the ON/OFF button to power the unit, and suspend the weighted electrode at the end of the unit’s cable over the side of the vessel and allow it to sink to approximately 2 m depth. Take a salinity and temperature reading and record these in the survey logbook.

-continued-
To initialize the hydroacoustic system, do the following:

1. Check all the cable connections including the:
   a. power,
   b. GPS cable to the GPS antenna,
   c. cable to the transducer,
   d. and the Ethernet cable to the computer.

2. On the laptop computer, check the IP address to ensure it will receive data from the DT-X unit.
   a. Go to Start > Settings > Control Panel > Network Connections > Local Area Connections
   b. Under the General tab, under This connection uses the following items: click the Internet Protocol (TCP/IP) item
   c. Click the Properties button
   d. Select the Use the following IP address radio button
   e. In the IP address field, type 192.168.1.9
   f. In the Subnet mask field, type 255.255.255.0
   g. Click OK and close the control panel.

3. Turn on the power switch in the DT-X control module Pelican case (a red LED will illuminate). After about 20 seconds a beep will sound.

5. Click on the INIT DT-X button. This will start the GPS feed and allow the unit to interrogate the transducer. A series of tones will sound.

6. A System Information window will appear which shows the status of various components. Click OK.

7. Click the CONFIG DT-X button.

8. The Configure Echosounder window opens.

9. Click the Load button and navigate to C: > Biosonics > VisualAcquisition6 > Config > Rockfish_Survey.acqcfg then click OK. This loads a number of parameters so that they don’t have to be specified each time. See the list of parameters specified below.

10. Under the Transducer 1 item in the hierarchical list, select the Environment item.

11. Enter the water temperature and salinity collected with the YSI meter, then click the Compute button.

12. Select the Data Logging item and change the File Prefix to the current district and the survey day, all separated by an underscore (e.g., NE_Day_6_)

13. Click OK to close the System Information window.

14. Click the START PINGS button to begin viewing the echogram on the screen (but not record the data), or click START ALL to view the echogram AND begin logging the data to hard drive. If you are logging data, note the file name being written to the drive in the lower right-hand corner of the window and write this in the logbook.

15. To stop logging data, click the CLOSE LOG button, or to close the log AND stop pinging entirely, click the END ALL button.

Loading the Rockfish_Survey.acqcfg Acquisition configuration file sets the following parameters (refers to items in the Configure Echosounder window):

- Transmit/Receive
  - Active Transmission
  - Transmit Pulse Duration (ms): 0.4
  - Start Range (m): 1
  - End Range (m): 70
  - Calibration Correction (dB): 0
  - Data Collection Threshold Level (dB): -80

- Sensors/Mounting
  - All default values used

- Environment
  - Temperature (°C): Set based on measured value at each station
  - Fresh Water: No

-continued-
o Salinity: *Set based on measured value at each station*

o Reference Depth (m): 1

o pH: 7

- **Bottom Detection**
  - Turned off

- **Echo Detection**
  - Turned off

- **Data Logging**
  - File Duration (mins): 30
  - File Prefix: Use the survey District_Day_#_ (e.g., NE_Day_3_)
  - File Suffix: leave blank
  - Logging Folder: C:\Biosonics\VisualAcquisition6\data
  - File Cutting Mode: Elapsed Time
  - File Naming Mode: Time stamped
  - Create DT4 Files: Yes
  - Create HAC Files: No
  - Create DTB Files: Yes

**IMPORTANT:** Make sure the program Visual Acquisition stops pinging before turning off the power to the DT-X surface unit.

With the unit actively pinging, a number of settings can be varied to change the way data is displayed. These settings can be changed via function keys or in some cases buttons in the Chart Toolbar.

- Pressing F1 at any time brings up the electronic .pdf Visual Acquisition 6 manual.

- Pressing F3 (or using the toolbar button) increases the display threshold by applying a higher (stronger) echo threshold to displayed data, which effectively reduces noise and filters out weaker ping returns. If there is a lot of feed or debris in the water, this can reduce clutter and make fish more apparent. It also “shrinks” fish echoes and makes them fainter. Note that this only affects the displayed echogram. The actual threshold of recorded data being logged is set in the System Information window when the system is configured.

- Pressing Shift + F3 (or using the toolbar button) decreases the display threshold.
Approximately a minute before the vessel begins driving down the first transect of a survey station, logging (recording) of the echogram should be initiated to ensure the system is operating correctly before entering the grid or star. For each station, the operator of the hydroacoustics will keep a detailed logbook in which they will record the

- date,
- fishing district the survey is taking place in,
- survey station name (e.g., Southeast Star 07),
- water temperature and salinity,
- exact time the echogram starts to be logged,
- full name of each .dt4 file being written when the echogram is being logged (e.g., SE_Day_12_20090824_120847.dt4),
- and the exact time the echogram logging is stopped.

The echogram data is logged to a .dt4 file by the Visual Acquisition application. The hydroacoustic technician sets the prefix of the file name to a logical string for later reference. For this project, the prefix should be set to the fishing district being surveyed, followed by the survey day number, and then the file number that the software assigns. An example would be SE_Day_12_20090824_120847.dt4 where SE stands for Southeast, Day_12 refers to the day of that district’s survey, and finally the software assigns a YearMonthDay_HourMinuteSecond string corresponding to the exact computer time the logging began. The .dt4 streams are broken into files corresponding to a predetermined time interval (e.g., 15 minute, 30 minute, etc.), each with the same file name but with the minute portion of the name advancing by the time interval in minutes for each file during a continuous recording session. For instance, the second file written during the session in the example given above would have the name SE_Day_12_20090824_123847.dt4 if the time interval was set to 30 minutes.

As the vessel approaches the first leg of the survey station, the hydroacoustic technician ensures that the threshold and depth of the echogram are set so they will see any fish in the hydroacoustic beam, and then begins logging the echogram to the computer hard drive. The technician confirms with the vessel operator that logging has begun and that they are prepared to transit and record the entire survey station. Record information related to the station in the logbook. If problems are encountered with logging the echogram or with the vessel navigating the station, it is best to begin the station over again logging a new set of .dt4 files.

-continued-
Once the vessel is on station and echogram logging has begun, the technician continues to monitor the echogram and the vessel’s progress through the station. Any significant numbers of fish should be accurately recorded as marks in the navigation program so that once logging of the station is complete fish schools can be located and sampled using video and live capture for species identification.

Once the hydroacoustic survey is complete, the technician should record the exact computer time when the .dt4 file logging was stopped in the logbook and discuss the location and strategy for acquiring video and live samples from fish schools in the station with the vessel operator. If the transducer is pole-mounted, it may be left in the water and continue to ping (though the echogram logging will be turned off).

These surveys represent a large investment in time and capital, so it is important to protect collected data by backing up the .dt4 files each day to a second, external hard drive. The .dt4 data is stored on the main computer hard drive at the following location: C:\BioSonics\VisualAquisition6\data. The prefix of the name of each file is set by the user when it was created in Visual Acquisition, so finding that day’s files is simply a matter of sorting the file list by file name or sorting the folder contents by the date the files were modified.
APPENDIX F. UNDERWATER VIDEO SYSTEM
Appendix F1.—Instructions for assembly and use of the Insite underwater video camera system.

Underwater video cameras are used to record images of rockfish in order to identify what species are present, and in what relative numbers. Outlined here are assembly instructions and usage guidelines for the components of the camera, light, and digital recording system for collecting underwater video. When used in conjunction with the hydroacoustic electronics, these components can put a significant demand on the vessel’s electrical supply. Make sure there is sufficient amperage (greater than 20 A) available through quality sine-wave inverters or auxiliary power before leaving the harbor, and it may be necessary to elevate the vessel’s engine idle speed at times to maintain sufficient output from the alternator especially when the camera lights are used.

Underwater video should be recorded at all stations surveyed. Conditions such as cloud cover, nekton in the water, and sea state affect the quality of video recorded, and this, in turn, affects the number of fish which can be identified in the recording. A calm sea state reduces camera ‘bounce’ in the water column and calm winds reduce the distance the passive drop camera trails behind the drifting boat. The limit of effective camera working depth depends on a number of factors including available ambient light and visibility. Typically, good footage can be recorded from the surface down to 25 to 35 m (14 to 19 fathoms). Occasionally conditions allow for useable recordings to be made from 35 to 45 m (19 to 25 fathoms) in depth, though recording good footage deeper than 45 m (25 fathoms) is rare. The drop camera system is equipped with an artificial light source, though this does not extend the useful working depth very much. Water turbidity generally creates a ‘blizzard’ effect when artificial light is used as it reflects off nekton near the camera lens. Discerning the difference between the similar-looking dark *S. ciliatus* and dusky *S. variabilis* rockfish can be aided with the addition of artificial light, and certain colors can only be seen at depth with artificial light due to different spectral attenuations of natural light filtered through water.

-continued-
For these rockfish surveys, Insite Pacific Inc. Pegasus™ and Pegasus Plus™ NTSC video cameras are used and recorded to a computer hard drive. The cameras and light sources are enclosed in a robust housing made from a rigid plastic trawl float and suspended in the water column via a hand-held cable over the side of the vessel (Figure 1). Colored plastic tape is wrapped around the cable at one-fathom intervals to indicate the approximate amount of cable that is paid out.

The vessel operator moves the vessel into the location identified during the hydroacoustic portion of the station survey and uses sonar or the Biosonics hydroacoustic echogram to locate the fish schools again. The vessel operator determines the direction the vessel will drift and position the boat accordingly so that it moves over the fish aggregation. The drift should be mostly passive though slight compensations for wind or tidal current can be made with the vessel’s engines as long as it does not cause the drop camera to ‘fly’ or get dragged by the moving boat and that the ship’s propeller does not pose a danger to overboard gear. The video camera operator views the footage being recorded in real time using a deck monitor and adjusts the camera depth accordingly to record as many fish as possible while ensuring the camera does not contact or become entangled with the bottom. Rockfish generally live in close proximity to the bottom in rocky habitat, and having the camera drift through the location while staying near the seabed usually leads to recording the greatest number of fish, but also requires a high level of vigilance by the operator to follow the terrain without damaging the equipment. Controlling the heavy camera and cable in deep water is a physically demanding task, which is compounded by waves, windy conditions, and strong tidal currents. When conditions allow, the camera cable can be temporarily locked into a ‘cam cleat’ mounted on the vessel’s rail. Camera retrieval can be made easier by engaging the vessel’s hydraulics and lifting the camera using a set of modified shims on a crab block which provide friction on the cable without damaging the wires inside. The camera should be lifted slowly and care must be taken so that the powerful hydraulics do not put excessive strain on any portion of the video equipment.

-continued-
Multiple drifts in a number of locations in each survey station should be done until sufficient video has been recorded to identify the general proportion of fish species in the station. The number of camera drops required depends greatly on the specific location. In stations with large aggregations of fish, hundreds of fish may be recorded per camera drop while more sparsely populated stations may result in few fish being recorded. Keep in mind that four to six stations may be surveyed per day and the amount of time spent attempting to acquire good video footage needs to be balanced against other work that needs to be accomplished. As general guidelines, the following points should be considered when deciding how long to record video at a given survey station:

- During past rockfish surveys, for every four or five fish recorded on the echogram, one fish has been identified from the video footage.
- Stars that require approximately 20 minutes to survey with hydroacoustics should receive two or three camera drifts of about five minutes duration through the center concentration of fish, and additional drifts over fish concentrations outside the star’s center.
- Grids should receive underwater video coverage at every major fish school observed on the echogram. A good goal is to observe approximately 100 fish per drift location on the video if practicable.
- The amount of video recorded may be influenced by water and light quality with more time needed to positively identify a sufficient number of fish under limited visibility or poor light conditions.
- Approximately as much time should be spent recording video as was spent acquiring the hydroacoustic echogram.

An example of the video log form is shown in Figure 2. The first column is the Index Number which will be filled in after the survey is complete and the information has been entered into a database. Enter the date, the name of the grid or star, and nearest Headland or Bay. The clock time corresponds with the time of day the video was recorded in an a.m./p.m. format. This time should be visible on the data overlay that the SecuritySpy™ video recording program overlays on each video file. A GPS position should be taken at the start and end of each drift when video is recorded and entered as the start and stop waypoint number on the video log form. The video recording stop time should be noted along with the approximate depth the camera was suspended (in fathoms). Any observations regarding water clarity or species seen can be entered in the comments field. Each video log sheet should have the header filled out that includes the year, the district being surveyed, the vessel, and which GPS was used to mark the waypoints.
Figure 2.

After returning to port, the video files will be transferred and edited to remove extraneous footage lacking identifiable fish. Each edited video file will be watched twice by a technician trained in identification of the common local rockfish species, and the respective species counts will be recorded. The proportions of each species represented in the video will be used to estimate their abundance by multiplying their percentage by the total estimated rockfish derived through the statistical expansion of the hydroacoustic counts. Black rockfish are easily identified on video based on obvious light-colored markings along the dorsal surface under ambient light underwater. Dark and dusky rockfish are more difficult to differentiate from each other. These latter two species are divided into three categories during analysis of the video. Individual species counts are made of 1) fish positively identified as dark rockfish, 2) fish positively identified as dusky rockfish, and 3) fish determined to be either a dark or dusky rockfish but which cannot be placed confidently under either species category.
Cameras, lights, and housing

Two NTSC cameras are housed in a rigid plastic trawl float along with a pair of LED lights, and these are attached to the end of a cable (Figure 1) which suspends the camera in the water column and transmits the data to the surface. The cable bundle has a fairing sheath consisting of many short streamers that reduces drag through the water by encouraging laminar water flow past the cable. The trawl float is cut into two hemispheres held together by four ¼” bolts (Figure 1). The support bracket for the cameras and lights is attached to the lower hemisphere of the housing, and the harness attaching the housing to the cable is attached to the upper hemisphere. The lights bolt directly to the support bracket and the cameras are held in place using a pair of stainless exhaust hose clamps. The housing itself is suspended from the surface cable using a braided line harness. It is safe to lift the system using the main cable where the fairing streamers are attached, and there is an aluminum pipe handle across the top of the housing for lifting the housing itself. *Never lift the housing using the black data cables below the braided harness lines.*

It should not be necessary to disassemble the trawl float housing camera system while underway. Giving the camera housing a fresh water rinse occasionally should be sufficient until the survey is over and the system gets disassembled into its component parts for storage. When removing the plugs from either the lights or camera *it is important not to pull on the cable* as this will break the solder at the wire/pin junction. The plug itself should be held firmly and pulled out of the accessory with a gentle rocking motion. When installing underwater plugs it is useful to lubricate the contact pins and holes with a small amount of silicone dielectric grease. The connector sleeve which screws the two plug halves together simply keeps the plug from separating and does not contribute to the waterproofing of the plug. Making it finger tight is sufficient.

Surface Video and Light Control Box

The surface end of the cable attaches to the face of the camera control box (Figure 3) via a 14-pin military-style connector. In the upper right-hand corner of the face plate is the 110v power input cable, a 2A fuse, a Firewire 400 port (IEEE 1394 High Speed Serial Bus), and the main power switch for the system. The lower portion of the control box face plate is split roughly into two halves, each side of which controls one camera and light set. A rheostat knob is used as a dimmer for the LED lights. A control override switch is present to enable or disable the use of the focus and zoom features of the cameras. The analog video signal enters the control box via the large 14-pin military-style connector and leaves the control box as a digital video feed via the Firewire 400 cable. Plug the other end of the Firewire 400 to 800 cable into the Firewire 800 port on an Apple Laptop where the application called SecuritySpy captures the live video feed.

-continued-
Appendix F1.–Page 6 of 10.

Figure 3.

**Recording Underwater Video to Computer Hard Drive**

Before starting up the video recording software, SecuritySpy, it is necessary to turn the power supply on in the camera control box via the toggle switch labeled ‘power on.’ After a few seconds launch the SecuritySpy application by clicking on its icon in the Launch Bar or by double clicking the shortcut on the desktop (Figure 4).

Figure 4.

-continued-
A live video feed from each of the two cameras will appear in its own window along with a Camera Status window. The individual camera windows may be resized or moved. A small text string appears in the upper left-hand corner of each camera window which will be embedded in the video file that will be recorded. Typically the text string would name the rockfish management district being surveyed followed by the camera’s number (e.g., Cam 1 or Cam 2), followed by the date and current time. The application will start up using the same parameters that were set the last time it was shut down, though it is a good idea to look at the text string in each camera window to verify that the correct information is being written to the video. To review or adjust most settings related to the cameras in SecuritySpy, select the menu item `Settings > Camera setup...` (or press Command-K; Figure 5).

In the resulting Camera Setup window either of the cameras’ parameters can be set by selecting the camera from the pull-down menu at the top of the window (Figure 6). In this window you can turn cameras on and off, rename the camera, turn the text overlay on or off and change the text string, and determine where the video file being generated will be saved.
To change the text overlay, select the camera from the pull-down menu and then click on the ‘Overlay settings…’ button. A new window will open (Figure 7). Type the desired information into the text box using ‘+d’ to add the date and time stamp. Once the settings are correct click the OK button to return to the Camera Settings window. It is necessary to now do the same step for the second camera, so select it from the pull-down menu and again click the ‘Overlay settings…’ button and enter the information for the second camera.

The locations of the files being written to the hard drive are shown in the ‘capture destination’ description at the bottom of the Camera setup window. If you wish to change the location the files are being written, click on the ‘Set…’ button and navigate to a new folder. Again, you must do this for each camera separately.

Once you are finished setting the parameters for both cameras, click OK to close the Camera Setup window.
To begin recording to disc, press Command-R (⌘-R). To stop recording, press Command-T (⌘-T). These commands affect both cameras simultaneously. To verify the recording status, look at the mode in the Camera Status window: “passive” means SecuritySpy is not recording while “active” means the program is recording the live video feed to disc (Figure 8).

![Camera Status window](image)

Figure 8.

The technician should ask the vessel operator the depth in fathoms before lowering the camera system over the side of the boat. The cable is lowered by hand over the side of the vessel and generally held by hand during deployment. The camera operator can compensate for wave-induced vessel movement to stabilize the camera’s picture, and can turn the cameras in a desired direction by twisting (i.e., rotating axially) the cable at the surface. If the cable needs to be left briefly unattended, it can be clamped in a cam cleat mounted on the rail of the vessel (Figure 9).

Colored plastic tape fathom markings are placed on the camera cable in 1-fathom (~2 m) increments, and the tape color changes every 5 fathoms. Depth measurements are in fathoms for easier comparison with a standard vessel’s electronics. Yellow tape bands are used from 0 to 5 fathoms, red from 6 to 10 fathoms, blue from 11 to 15 fathoms, green from 16 to 20 fathoms, and black/white from 21 to 25 fathoms.

![Camera cable with fathom markings](image)

Figure 9.

-continued-
When deploying the camera, pay out sufficient cable to allow the camera housing to sink to within one fathom of the sea floor, but not contact it. Recording of the video should begin as soon as the cameras are deployed over the side of the vessel and recording should continue until the cameras are retrieved at the end of the drift. All relevant data to the beginning of the drift should be entered on the video log form (Figure 2). The Index No. column will be left blank during the survey and is only used when entering the information in a database. The date, survey station, and nearest headland should be entered for every drift with the camera. The clock time columns are for entering the time of day in an a.m./p.m. format as it was seen in the text overlay in the video windows. GPS waypoints for the beginning and end of each drift as well as the approximate average depth should be recorded in the appropriate columns.
APPENDIX G. LIVE CAPTURE SAMPLING PROCEDURES
Appendix G1.—Live capture sampling procedures

Rockfish caught are examined to determine their species, sex, and length (tip of snout to tail fork, to the nearest 1 cm), and these data are recorded on a live-capture sampling data form (Figure 1). Each capture should be associated with GPS coordinates. Notes on the sexual maturity of rockfish are made in the comments column of the live-capture sampling form if they are extruding eggs, larval young, or sperm. Table 1 describes the main characteristics differentiating black, dark, and dusky rockfish. The same information is shown in photographic form in Figures 2, 3 and 4. Sex is determined by examining the external structure of the urogenital papillae (Figure 5). Learning to correctly identify rockfish species and sex takes time and practice, so if difficulty is encountered seek the advice of someone on the survey with more experience. If no sex determination can be made confidently it is better to code the fish as unknown (code 3) rather than guess. Although the main objective of this survey is to document black rockfish populations, all species captured should be recorded on the sampling forms.

![Rockfish Live Capture Sampling Form](image)

**Figure 1.** -continued-

<table>
<thead>
<tr>
<th>Species</th>
<th>Length</th>
<th>Sex</th>
<th>Wypt</th>
<th>Grid / Star No.</th>
<th>Comments</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>142</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dusky</td>
<td>172</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dark</td>
<td>173</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>China</td>
<td>149</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yellow</td>
<td>145</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tiger</td>
<td>148</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>China</td>
<td>149</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yellow</td>
<td>155</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Species: Black = 142 Rougheye = 151  Sex: 1 = Male  China = 149 Yellowtail = 155  2 = Female  Dark = 173 Tiger = 148  3 = Unknown  Yellow = 145
Table 1.—Morphological characteristics differentiating black, dark, and dusky rockfish.

<table>
<thead>
<tr>
<th>Rockfish Species</th>
<th>Black S. melanops</th>
<th>Dark S. ciliatus</th>
<th>Dusky S. variabilis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dorsal/lateral body color</td>
<td>Black or dark grey, some mottling possible</td>
<td>Nearly uniform black or dark greenish-brown</td>
<td>Greenish-brown</td>
</tr>
<tr>
<td>Ventral body color</td>
<td>Light grey or white</td>
<td>Nearly uniform black or dark grey, occasionally with an orange or pink color hue</td>
<td>White or beige with a pink or orange hue</td>
</tr>
<tr>
<td>Fin color</td>
<td>Black</td>
<td>Black or dark grey</td>
<td>Tinged with a pink or orange hue</td>
</tr>
<tr>
<td>Symphyseal knob</td>
<td>Absent</td>
<td>Present</td>
<td>Present</td>
</tr>
<tr>
<td>Lower jaw pores</td>
<td>No visibly large pores</td>
<td>3 large pores on each side of lower jaw</td>
<td>3 large pores on each side of lower jaw</td>
</tr>
</tbody>
</table>

Figure 2.—Black rockfish *Sebastes melanops* distinguishing characteristics.
Figure 3.–Dark rockfish *Sebastes ciliatus* distinguishing characteristics.

Figure 4.–Dusky rockfish *Sebastes variabilis* distinguishing characteristics.
Fish caught at depths below 35 meters (19 fathoms) may suffer barotrauma when they are brought to the surface. The swim bladder expands and gasses dissolved in the fish’s tissues come out of solution, and the fish may become too buoyant or stunned to swim back down unassisted. The various species tend to react to barotrauma differently, with black rockfish being relatively hardy and able to dive again with minimal assistance, while dusky rockfish caught at the same depth may experience more difficulty recovering. A mechanical release-at-depth device has been used to reintroduce the fish to deep water before letting them go in order to minimize the effects of barotrauma. The device is made from a modified nylon hobby clamp with a fishing weight suspended at the end of a fishing line, and is designed to open when the line is tugged (Figure J1.6). The rockfish is gently gripped at the lower mandible by the padded clamp jaws and lowered into the water and then sinks passively using the fishing weight. Once 15–20 m of line has been paid out, a sharp tug or two on the line should open the clamp and release the fish.
If a significant number of the fish being caught are suffering barotrauma and too much time is being spent trying to reintroduce the fish to depth, or attempts to sink the fish are unsuccessful, live-capture sampling should be suspended until a new location is sampled.
Appendix G2.—Instructions for operating an Oilwind 03-16 electronic jig machine.

An electronic commercial fishing jig machine (model 03-16 Oilwind Inc.) and rod and reel are used to live-capture samples using artificial bait hooks. The electronic jig machine must be connected to a 24 volt direct current (24v DC) power supply. Two 12 volt automotive batteries are connected in series in order to achieve 24 volts. Once power is supplied to the jig machine, it is automatically turned on. In order to turn the machine off, it is necessary to unplug the machine or otherwise interrupt the power to it.

The jig machine has many sophisticated functions, but basic operation is straightforward. Complete operating instructions for the Oilwind jig machine can be found in Appendix G3. General instructions for rigging jig gear and hooks can be found in Appendix G4. On the keypad, pressing the Down button causes the machine to pay out line until the weight reaches the bottom and the machine starts fishing (Figure 1). Because the sampling generally occurs over rocky bottom, it is preferable not to have the jig gear contact the sea floor but rather fish a few meters above it. The maximum depth can be set by pressing the Depth Adjust button and then pressing either the Plus or Minus buttons to change the maximum depth in fathoms, and then pressing the Down button in order to fish at that depth (Figure 1). Ask the vessel operator to inform you of the current depth in fathoms, and to continue to update you if the depth changes, and make adjustments to the maximum fishing depth as required. Losing the fishing weight and the jig hooks is very disruptive to the sampling process and should be avoided if possible. Rockfish can generally be found from approximately two to six meters (one to three fathoms) above the sea floor.

Figure 1.

-continued-
The jig machine is designed to sense when fish have been caught and may sound a warning noise, or the operator may observe the roller arm bouncing from the struggling fish. Pressing the Stop / Retrieve button once stops the fishing operation, and pressing the button a second time causes the jig machine to reel the gear back to the surface. At approximately 5 meters from the surface the jig machine will make a series of beeping sounds and will slow down the retrieve speed until the hooks arrive at the surface. The stopper ring separating the fishing line from the hook leader will reach the roller arm and stop automatically. The operator can then swing the weight over the boat’s rail and remove the fish from the hooks. Care should be taken not to injure the fish unnecessarily. Once the fish have been removed the weight can be suspended back over the water and fishing can resume while the operator measures each fish.